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Abstract

Lymphatic malformations and other conditions where lymphatic function is disturbed in the 

respiratory tract present diagnostic and therapeutic challenges. Advances in lymphatic 

development, growth regulation, function, and imaging have increased the understanding of 

lymphatics, but the airways and lungs have not received as much attentions as many other organs. 

The lung presents challenges for studies of lymphatics because of the complex, densely packed 

three-dimensional architecture of the airways and vasculature, and because it cannot readily be 

examined in its entirety. To address this problem, we developed methods for immunohistochemical 

examination of the lymphatics in mouse lungs, based on approaches we devised for lymphatic 

vessels and blood vessels in whole mounts of the mouse trachea. This report provides a practical 

guide for visualizing by fluorescence and confocal microscopy the lymphatics in mouse airways 

and lungs under normal conditions and in models of disease. Materials and methods are described 

for immunohistochemical staining of lymphatics in whole mounts of the mouse trachea and 200-

μm sections of mouse lung. Also described are mouse models in which lymphatics proliferate in 

the lung, blocking antibodies for preventing lymphatic growth, methods for fixing mouse lungs by 

vascular perfusion, and techniques for staining, visualizing, and analyzing lymphatic endothelial 

cells and other cells in the lung. These methods provide the opportunity to learn as much about 

lymphatics in the lung as in other organs.
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1 Introduction

The purpose of this chapter is to provide a practical guide for obtaining images of lymphatic 

vessels in mouse airways and lungs for examination and measurement. The procedures 

described are derived from methods that we developed to examine lymphatic vessels and 

blood vessels in whole mounts of the mouse trachea after immunohistochemical staining. 

The trachea proved to be very informative, because all lymphatics and blood vessels are 

visible in 3-dimensions when the cylindrical organ is cut longitudinally, stained 

immunohistochemically as a whole mount, and viewed by fluorescence or confocal 

microscopy after flat mounting on a microscope slide. By comparison, the lung presents 

HHS Public Access
Author manuscript
Methods Mol Biol. Author manuscript; available in PMC 2019 May 06.

Published in final edited form as:
Methods Mol Biol. 2018 ; 1846: 161–180. doi:10.1007/978-1-4939-8712-2_11.

A
uthor M

anuscript
A

uthor M
anuscript

A
uthor M

anuscript
A

uthor M
anuscript



challenges for this type of analysis because of the size, complex, densely packed three-

dimensional architecture of the airways and vasculature, and natural tendency to collapse 

when the thorax is opened. Also, the commonly used lymphatic marker LYVE-1 is not 

useful because of confounding expression by endothelial cells of lung alveolar capillaries. 

Other potentially problematic features of mouse lungs are differences from human lungs that 

include the limited bronchial circulation, presence of cardiac muscle in the wall of large 

pulmonary veins, and sparseness of lymphatics in the visceral pleura. Nonetheless, many 

genetic, pharmacologic, and other powerful experimental tools underscore the value of 

studies of lymphatics in mice. Although the understanding of lymphatics in mouse lungs is 

still at an early stage [1], reports have described the distribution of lymphatics under normal 

conditions and changes in lymphatics of mouse airways or lungs after administration of 

noxious substances [2–4] or infectious organisms [5–11], transgenic overexpression of 

VEGF-C or interleukin-1beta [12–14], effects of rapamycin [13], and lung transplantation 

[15]. Here, we describe materials and methods that have been found to be useful for 

visualizing by fluorescence and confocal microscopy the lymphatics in mouse lungs under 

normal conditions and in models of disease.

2 Materials

2.1 Transgenic Mice for Studying Lung Lymphatics

1. Prospero homeobox 1-enhanced green fluorescence protein (Prox1-EGFP) 

transgenic mice are available from the Mutant Mouse Resource Center at Davis 

as strain MMRC #036644- UCD and from laboratories that use them [16]. 

Although the green fluorescence of lymphatics in these mice fades rapidly after 

fixation with paraformaldehyde, it can be amplified and made permanent by 

immunohistochemical staining for EGFP. Prox1-EGFP mice can be genotyped 

by the presence of green fluorescence of Prox1-EGFP in lens cells after a bright 

light is shone into their eyes.

2. CCSP-rtTA mice are available from the Jackson Laboratory in FVB/N strain 

(JAX #006222) and C57BL/6 strain (JAX #006232). TetO-VEGF-C mice have 

been made by Kari Alitalo at the University of Helsinki, Finland [17]. Breeding 

these mice yields double transgenic mice [14]. Breeding the double-transgenic 

mice with Prox1-EGFP mice yields triple transgenic Prox1-EGFP/CCSP/VEGF-

C mice. Conventional PCR methods can be used for genotyping.

3. Like wild-type mice, these transgenic mice should be housed under pathogen-

free conditions in filter-top cages to avoid accidental respiratory tract infections, 

which can have profound effects on lung lymphatics.

2.2 Doxycycline Water to Induce Lymphatic Growth in CCSP/VEGF-C Transgenic Mice

For studies of adult mice, doxycycline (Sigma D8991) is administered in drinking water at a 

concentration of 1 mg/mL (0.1%) with 4% sucrose (40 mg/mL) added to mask the bitter 

taste.
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2.3 Reagents for Blocking VEGF-C Mediated Lymphatic Growth

Rat monoclonal antibodies DC101 to mouse VEGFR-2 and mF4– 31C1 to mouse VEGFR-3 

have been made by ImClone/Eli Lilly. Adeno-associated viral soluble VEGFR-3 (AAV-

sVEGFR3; VEGF--C/D Trap) has been made by Kari Alitalo, University of Helsinki, 

Finland.

2.4 Anesthetics

Ketamine (87 mg/kg) plus xylazine (13 mg/kg) are injected intraperitoneally together in the 

same syringe (see Note 1).

2.5 Inoculation and Perfusion Apparatus

1. 60° sloping platform made from wood, plastic, or Styrofoam is used for 

intratracheal administration of substances.

2. Fiber optic light source (Dolan-Jenner model 180) is used for illumination.

3. Binocular magnifier (Donegan Optivisor from Fisher Scientific #NC1227372) is 

used for magnification for inoculation, surgery, and dissection.

4. 100 μL micropipette is used to measure inoculum onto clean Parafilm or other 

water-repellent surface.

5. Inoculum is injected intratracheally with a Clay Adams Intramedic PE10 

polyethylene tubing (Becton Dickinson #427401) attached to a 28-G needle on a 

0.5 mL syringe (Becton Dickinson #329465).

6. 1-liter aspirator bottle with a hose outlet at the bottom (Kimax #14607–1000) is 

used for perfusion of fixative.

7. Aneroid sphygmomanometer (Medline #MDS9380) is used to generate a fixed 

pressure for perfusion of fixative from the aspirator bottle.

8. Silicone tubing and rubber bung are used to connect the sphygmomanometer and 

perfusion tubing to the aspirator bottle.

9. Male Luer-to-Luer adapter (Cole Palmer Cadence #6183) attaches the silicone 

perfusion tubing to an 18-G plastic catheter (Becton Dickinson #511097), 30 mm 

in length that serves as the perfusion cannula.

10. Plastic tray similar to a restaurant dinner tray serves as a perfusion table that 

collects fixative during the perfusion.

11. The perfusion board is made from cork or a thick sheet of silicone or polystyrene 

foam (Styrofoam).

12. Paper tape is used to wrap the limbs of anesthetized mice, and push-pins are used 

to fix the tape to the perfusion board.

1.Written records must be kept on the use of ketamine, as for other controlled substances.

Baluk and McDonald Page 3

Methods Mol Biol. Author manuscript; available in PMC 2019 May 06.

A
uthor M

anuscript
A

uthor M
anuscript

A
uthor M

anuscript
A

uthor M
anuscript



13. A rubber band attached to front teeth and perfusion board is used to keep the 

neck and trachea straight during the perfusion.

14. A shadow-free surgical lamp is used for illumination during surgery, perfusion, 

and dissection.

15. 70% ethanol is used to moisten mouse fur before surgery and dissection.

2.6 Instruments for Surgery and Dissection

1. 140-mm long coarse scissors are used to open the chest.

2. 90-mm long fine scissors from Fine Science Tools #14060–09 are used to cut the 

heart and trachea.

3. Hemostat (locking clamp) with curved smooth tips is used to clamp tubing from 

perfusion bottle.

4. Hemostat (locking clamp) with straight serrated tips is used to clamp the rib cage 

after opening the chest wall.

5. Dumont #3c or #5 11-cm straight forceps from Fine Science Tools #11231–20 or 

#11252–20 are used for dissection.

6. Coarse straight forceps (10 mm long with serrated tips from Fine Science tools 

#11050–10 are used for surgery and dissection.

7. Scalpel handle and #10 rounded or #11 straight scalpel blades are used for 

surgery and dissection.

8. Surgical silk ligature 3–0 is used to ligate trachea after inflation with fixative.

9. Binocular dissecting microscope is used for magnification.

2.7 Fixatives, Buffers, Incubation Solutions, Embedding Media

2.7.1 Fixative: 1% Paraformaldehyde in 1× Phosphate-Buffered Saline (PBS)
—See Subheading 3.4 Making 1% paraformaldehyde.

2.7.2 Calcium and Magnesium-Free PBS and PBS–Triton—The composition of 

1× PBS is 0.2 g/L KH2PO4, 2.16 g/L Na2HPO4∙7H2O, 0.2 g/L KCl, 8.0 g/L NaCl. Store at 

room temperature. 1× PBS is prepared by diluting 10× PBS with water 1:10. PBS–Triton is 

made by adding 3 mL of Triton X-100 to 1 L of 1× PBS. Stir with magnetic stirrer until 

dissolved.

2.7.3 “Immunomix” Antibody Incubation Medium—Immunomix, consisting of 1× 

PBS containing 0.3% Triton X-100, 0.2% bovine serum albumin BSA, and 0.1% sodium 

azide, is used for primary antibody incubations for immunohistochemistry.

2.7.4 Cryoprotection Solution—30% sucrose dissolved in PBS is used for 

cryoprotection of tissues during freezing.
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2.7.5 Medium for Embedding and Freezing Tissues—Tissues are embedded in 

OCT.

2.7.6 “SuperDAPI” Mounting Medium—“SuperDAPI” consists of VECTASHIELD 

with DAPI mounting with additional DAPI at a final concentration of 50 μg/mL.

2.7.7 Coverslip Sealing Resin—Tissues are mounted on microscope slides with 

Cytoseal.

2.7.8 Sylgard Silicone Resin for Making Dishes to Pin Whole Mounts—Sylgard 

184 silicone elastomer resin is available as a kit (Fisher Scientific # NC9965371).

2.7.9 Stainless Steel Pins for Tracheal Whole Mounts—10-mm long headless 

stainless steel pins (“Austerlitz Minutien” insect pins: 0.10, 0.15 or 0.20 mm diameter, Fine 

Science Tools #26002) are used to secure tracheal whole mounts to the layer of Sylgard in 

dishes.

2.8 Immunological Reagents

1. Antibodies used for immunohistochemical staining of lymphatics and other types 

of cells in mouse lungs are listed in Table 1. Combinations of antibodies that 

stain lymphatics together with other cell types can be very informative. Staining 

for alpha-smooth muscle actin in smooth muscle cells complements staining for 

lymphatics because it makes visible the branching architecture of bronchi and 

large blood vessels. The smooth muscle cell layer is sufficient different in 

bronchi, pulmonary arteries, and pulmonary veins that it can be used to 

distinguish each of these structures from the others.

2. Primary antibodies, including fluorophore-conjugated secondary antibodies 

(Jackson Immunoresearch), are used at a working concentration of 1 μg/mL 

(1:100–1:500 dilution) (see Note 2).

3 Methods

3.1 Induction of Lymphatic Growth in CCSP/VEGF-C Transgenic Mice by Doxycycline

1. Adult CCSP/VEGF-C mice are given doxycycline at a concentration of 1 mg/mL 

(0.1% doxycycline) in drinking water for 7 days after weaning (P28–P35) or 

later. Newborn CCSP/ VEGF-C mice, which are more sensitive to doxycycline 

than adults, are given doxycycline at a concentration of 0.001– 0.01 mg/mL, 

depending on their age [14].

2. To prepare doxycycline in drinking water, weigh 1 g doxycycline HCl and 40 g 

sucrose and add to a large screw-cap bottle with magnetic stirrer. Fill bottle to 

1000 mL with deionized water and stir to dissolve (see Note 3)

2.Secondary antibodies that are preabsorbed for other species are better, but more expensive, than unabsorbed ones.
3.About 150 mL of doxycycline is needed per water bottle for mouse cages. Make sure the water bottles do not leak. As doxycycline is 
light-sensitive, the water bottle should be shielded from light. Avoid aluminum foil as shielding as mice will eat it. Doxycycline water 
should be replaced every 2–3 days to ensure activity.
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3.2 Procedures for Inducing Lung Injury

1. Mycoplasma pulmonis bacteria (strain CT7, 106 organisms per mouse [5]) and 

influenza A virus (H1N1 strain PR8, 100 Units per mouse [19]) can be given to 

anesthetized mice by intranasal inoculation of 50 μL of inoculum in 0.9% NaCl 

or PBS in a Class 2 laminar flow hood in the vivarium.

2. Hold anesthetized mouse vertically by the scruff of the neck and slowly pipette 

50 μL of inoculum into the nostrils, by giving 25 μL per nostril. A change in the 

breathing pattern is evidence that the inoculum entered the lungs.

3. Intranasal inoculation is easy, but there is a risk that some or all of the inoculum 

is swallowed, and the amount inhaled is difficult to determine (see Note 4).

4. Intratracheal administration via a cannula inserted through the mouth [20] is a 

more reliable route for inoculation when a reproducible dose is important, as for 

LPS (2.5 mg/kg, Sigma L2880, serotype 055:B5) or bleomycin (0.5–2 Units/kg, 

Teva Pharmaceuticals).

5. After giving ketamine–xylazine anesthesia, suspend the mouse by its front teeth 

with a rubber band attached to the 60° sloping platform.

6. Use a bright fiber optic light to illuminate the pharynx and larynx through the 

skin.

7. A binocular magnifier can be useful to visualize the larynx while leaving both 

hands free.

8. Using blunt forceps, open the mouth wide and pull the tongue out and to one 

side. The diamond-shaped opening of the larynx should be visible, with the vocal 

cords pulsating at the bottom of the pharynx.

9. Measure the volume of inoculum with a pipette and expel it as a compact drop 

onto the Parafilm (see Note 5).

10. Draw into the syringe 50 μL of air and then all of the drop of inoculum (see Note 

6). Inject the inoculum followed by the air into the trachea via the syringe 

attached to the cannula inserted between the vocal cords.

11. Remove the mouse from the sloping platform and keep it warm with a heat lamp 

until it recovers from the anesthetic.

3.3 Pretreatment with Antibodies or Soluble VEGFR-3 to Block Lymphatic Growth

1. Function-blocking rat monoclonal antibodies can be used to block VEGFR-2 

(clone DC101) and/or VEGFR-3 (clone mF4–31C1) (ImClone Systems/Eli Lilly, 

New York, NY) [7]. Inject antibodies i.p. at a dose of 0.8 mg in a volume of 200 

4.Appropriate safety precautions should be taken for Mycoplasma pulmonis organisms, which are pathogenic in mice but not in 
humans, and influenza A virus which is pathogenic in both.
5.The volume of intratracheal inoculations should be no more than 2 μL per gram of mouse, e.g., 50 μL for a 25-g mouse, to avoid the 
risk of impairing respiration.
6.Insert the tubing through the pharynx and larynx into the trachea, and slowly and gently inject the inoculum. The air buffer serves to 
push the inoculum deep into the lungs. Quickening of breathing is evidence of successful administration.

Baluk and McDonald Page 6

Methods Mol Biol. Author manuscript; available in PMC 2019 May 06.

A
uthor M

anuscript
A

uthor M
anuscript

A
uthor M

anuscript
A

uthor M
anuscript



μL of 0.9% sterile NaCl solution per mouse 1 day before infection, then every 

other day for 14 days. Rat IgG (Jackson ImmunoResearch Labs #012–000-003) 

is used as a control.

2. As another approach for blocking VEGFR-3 signaling, treat mice with a 

recombinant AAV-derived soluble VEGFR-3 receptor that absorbs its ligands 

VEGF-C and VEGF-D (VEGF-C/D Trap). Inject 150 μL of AAV, at a 

concentration of approximately 4.5 × 109 virus particles per mL, via a tail vein 1 

week before the study day [12].

3.4 Making 1% Paraformaldehyde Fixative

1. To make 1 L of 1% paraformaldehyde solution, add 10 g of powdered 

paraformaldehyde to a 1-L Pyrex flask with a magnetic stirring bar (see Note 7).

2. Add approximately one-third of the total final volume of distilled or de-ionized 

water. Stir with a magnetic stirrer. The result will be a cloudy white suspension.

3. Heat the suspension carefully to 55–60 °C on a hot plate with magnetic stirrer in 

a fume hood. Slowly and carefully add 1 N NaOH drop by drop until the 

suspension changes from cloudy white to clear. Only a few drops are needed. 

The suspension will suddenly turn almost clear, but can contain some suspended 

white precipitate. If the temperature rises above 65 °C, discard the suspension 

and start over. Allow the suspension to cool and then filter it with coarse filter 

paper in a funnel to get a clear solution.

4. Add sufficient 10× PBS to achieve a final PBS concentration of 1× and allow the 

suspension to cool. When the solution reaches room temperature adjust the pH to 

approximately 7.4 by adding HCl or NaOH drop by drop. Adjust the volume to 

the correct final value by adding distilled or de-ionized water.

5. Store 1% paraformaldehyde at room temperature in a tightly capped bottle for up 

to 2 weeks. Discard if a precipitate forms (see Note 8).

3.5 Fixation, Pulmonary and Cardiac Perfusion, Dissection, Lung Inflation

1. After anesthesia, position the mouse ventral side up on the dissection board. 

Pinch rear paws to ensure adequate anesthesia by lack of reflexes. Secure the 

mouse to the dissection board with tape around limbs and push pins. Hold the 

head flat with a rubber band placed between the teeth to keep the trachea 

straight.

2. Moisten the fur with 70% ethanol, and cut and remove the skin to expose the ribs 

and ventral chest wall.

7.For safety, wear gloves, mask, and personal protective clothing/equipment. Work in a fume hood to avoid breathing formaldehyde 
fumes. Also avoid breathing paraformaldehyde powder.
8.Do not freeze aliquots of paraformaldehyde in solution, as the activity will be lost. Do not use formalin (37% paraformaldehyde 
+ 15% methanol) as the fixative. Local safety regulations may require bottles to have warning labels of “Carcinogen” or similar. 
Dispose of waste paraformaldehyde in line with local safety regulations.
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3. Using coarse scissors, cut the chest open to make a U-shaped flap. The base of 

the U should be at the level of the eighth rib and across the sternum. Avoid 

cutting the lungs by gently moving them away from the scissors. Also avoid 

cutting the diaphragm to prevent the abdominal contents from getting in the way. 

The vertical portion of the U should end at the level of the fourth rib. Reflect the 

chest flap and clamp it with the serrated-tipped hemostat.

4. Hold the beating heart with coarse forceps and, using the fine scissors, make two 

shallow cuts about 2 mm long, one at the origin of the pulmonary artery (cut 1 in 

Fig. 1) and the other at the tip of the left ventricle (cut 2 in Fig. 1). Gently tear 

open the left and right atria with fine forceps to create an exit route for blood and 

perfused fixative (see Note 9).

5. Insert the 18-G perfusion catheter into the origin of the pulmonary artery and 

perfuse fixative at a pressure of 20 mmHg to flush the pulmonary circulation 

until the lungs turn white. This step removes many blood cells trapped in the 

pulmonary circulation.

6. Next, insert the perfusion catheter into the aorta through the opening in the left 

ventricle and perfuse the systemic vasculature with fixative for 2 min at a 

pressure of 120 mmHg.

7. Using the fine scissors, make a shallow 1-mm cut in the trachea at the level of the 

third cartilage ring (cut 3 in Fig. 1). Do not cut all the way through the trachea. 

Keep the trachea attached to the esophagus.

8. To expand the lungs, insert the perfusion catheter through the incision in the 

trachea and inflate the lungs at a pressure of 20 mmHg. Tie the trachea with a 3–

0 surgical silk ligature between the catheter and the tracheal bifurcation to 

maintain the expansion.

9. Cut through the entire thickness of the trachea at the rostral end and peel the 

trachea away from the esophagus. Cut the vena cava and esophagus just above 

the diaphragm, remove the trachea and lungs as a single unit, and immerse in 

about 5 mL of fixative for 1 h at room temperature in a 6-well dish.

10. Wash with several changes of PBS for 1 h at room temperature.

11. Cut the left lung transversely into three portions with a scalpel, such that the 

middle portion contains the main bronchus, pulmonary artery, and pulmonary 

vein cut in cross section. This middle portion should be about 5 mm thick and 

located approximately 3 mm below the lung hilum. This part of the left lung is 

particularly useful for systematic analysis, as the main airways and vessels have 

a reproducible orientation (Fig. 1). The four lobes of the right lung can be kept as 

one piece.

9.When creating a route for outflow of blood and fixative during the perfusion, use a toothed forceps and do not cut the heart atria with 
scissors, as there is a risk of accidental cutting of the aorta or other structures by mistake.
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12. After the tissues have been fixed and washed, they should be cryoprotected by 

soaking overnight at 4 °C in 30% sucrose in PBS. Use about ten times the 

volume of 30% sucrose solution per volume of tissue. Make 1 L of 30% sucrose 

by dissolving 300 g sucrose in 1 L of 1× PBS using a magnetic stirrer. Store at 

4 °C for a few weeks. Discard if cloudy or mold can be seen growing.

13. Embed the three portions of the left lung flat in OCT medium in three small 

plastic 5 mL disposable beakers (Fisher # 02–544-30), and freeze them as 

cryostat blocks using dry ice. Embed and freeze the entire right lung as a single 

block. Pour just enough OCT medium to cover the bottom of the embedding pot, 

then place the tissue in the pot in the desired orientation, and freeze the bottom 

layer of OCT on dry ice. When frozen, add more OCT to cover the frozen 

specimens. Freezing the tissue in this stepwise manner prevents the lungs from 

floating to the top of the OCT and losing their orientation. Store the frozen OCT 

blocks in labeled Ziplockbags at −20 °C. Frozen blocks keep for at least 2 years 

in a −20 °C freezer.

3.6 Cutting Thick Floating Lung Sections

1. Cut lung sections at 200 μm thickness using the block- trimming function of a 

Microm or Leica cryostat cooled to −22 °C. Use the anti-roll bar to stabilize and 

flatten the sections.

2. Pick up each thick section by the edge with fine forceps and quickly dip it 

directly in PBS in a 6-well dish or similar. Avoid gripping and damaging the 

tissue itself in the section. The OCT will dissolve, but the lung sections will float 

initially.

3. Wash carefully several times with PBS or PBS–Triton using a plastic pipette to 

remove the dissolved OCT, taking care not to discard the sections with the wash 

solution (see Note 10).

3.7 Preparation of Immunomix Antibody Incubation Medium

Add 3 mL of Triton X-100, 2 grams of BSA, and 10 mL of 10% sodium azide solution to a 1 

L bottle and fill to 1 L with 1× PBS. Add a magnetic stirring bar and stir slowly to dissolve 

the BSA. If you attempt to dissolve the BSA quickly, it will clump and take significantly 

longer to completely dissolve (see Note 11).

3.8 Incubation Procedure for Immunohisto- chemistry

1. Remove fixative from specimens with several washes of PBS. Time is not 

critical, provided all of the fixative is rinsed out; more changes, and longer is 

better. Usually 6 × 10 min is enough.

10.Most air bubbles in the lung will come out during this process or during the incubation steps.
11.Sodium azide is very toxic and should be handled with care. Please review the accompanying safety sheet before handling. Wear 
gloves, mask, and protective clothing. Use a large weighing dish to avoid making dust or spilling on the weighing balance. For safety, 
sodium azide is best handled as a solution. Make a 10% aqueous solution by carefully dissolving 10 g sodium azide powder in 100 mL 
of deionized water. For safety, sodium azide is best stored and handled as a solution in a break-proof bottle surrounded by a safety 
container.
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2. Immerse lungs in about 5 mL of 30% sucrose in PBS at 4 °C in a 6-well dish. At 

first, lungs float because they are less dense than the sucrose solution, but when 

they are fully infiltrated, they sink to the bottom of the tube. Sucrose infiltration 

helps in the embedding step, as the sucrose has a similar viscosity to OCT. Lungs 

can be stored in sucrose for several days. Tracheas can be processed as whole 

mounts immediately without sucrose infiltration.

3. Incubate lung sections in Immunomix incubation medium containing one or 

more primary antibodies AND 5–10% blocking serum from the host species in 

which the secondary antibodies are raised (usually goat or donkey). The blocking 

step with normal serum reduces nonspecific staining by the primary antibodies. 

Combinations of primary antibodies must be raised in different species, e.g., 

rabbit + goat + rat. Incubate tissues at room temperature for at least 6 h 

(overnight is better) in a 6-well dish on a mechanical rotator.

4. Wash sections with several changes of PBS–Triton for 5 min each. Wash whole 

mounts with PBS–Triton for a minimum of 6 h or overnight at room temperature.

5. Incubate for 1–4 h or longer (overnight is best) for whole mounts in fluorescent 

secondary antibodies diluted 1:500 in PBS–Triton. Do not use serum in this step. 

Secondary antibodies conjugated to Cy3 can be used for the red channel, 

conjugated to Alexa 488 for the green channel, and conjugated to Alexa 647 for 

the far-red channel of fluorescence or confocal microscopy.

6. Repeat the wash step with PBS–Triton.

7. After washing, fix the tissues again briefly for 2 min in 1% PFA. This important 

step helps to prevent fading and preserves the fluorescence by fixing the labeled 

antibodies. Wash briefly (3 × 2 min) with PBS to remove the fixative.

8. Gently fish out individual lung sections from the incubation dish with fine 

forceps. Hook the forceps under the section and lift up, like picking up spaghetti 

with a fork. Do not grasp the sections directly to avoid mechanical damage. 

Transfer the sections into a small volume of SuperDAPI in a watch glass or 

depression slide (VWR #470005–634). The sections will become clear and 

almost invisible as the SuperDAPI medium infiltrates them.

9. To prepare SuperDAPI, make DAPI stock solution by dissolving DAPI dilactate 

(Sigma; D9564) at 1 mg/mL in deionized water. Store this DAPI stock bottle in 

the dark at 4 °C.

10. Next, take a fresh 10 mL dropper bottle of VECTASHIELD mounting medium 

(H-1000). Pipette 500 μL of DAPI stock solution into an empty glass dropper 

bottle. Add VECTASHIELD drop by drop and swirl to mix it. Repeat a few 

times to dilute the DAPI solution with the entire 10 mL volume of 

VECTASHIELD and mix well. Label the bottle as SuperDAPI and keep it 

refrigerated in the dark (see Note 12).

11. Mount the sections in SuperDAPI medium on glass slides, using as little 

mounting medium as possible. Transfer the lung sections one at a time with fine 
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forceps by hanging them on the tips, as above. Gently spread out the sections flat 

and orient them in the desired direction by prodding them with the tips of the 

forceps. Cover the mounted sections with coverslips. If you have used too much 

mounting medium and the coverslips are floating, absorb the excess by blotting 

with paper towels.

12. Carefully paint the edges of the coverslips with Cytoseal 60 (Fisher Scientific 

#831016) to seal them to the glass slides. Use a fume hood for this step, as 

Cytoseal 60 contains the volatile and noxious solvents, toluene and butyl benzyl 

phthalate. Allow the Cytoseal to dry for about 1 h in a fume hood at room 

temperature before viewing the slides on a microscope (see Note 13). Store 

slides in a slide box in the dark in a refrigerator. The fluorescence should last up 

to 1 year.

3.9 Procedures for Tracheal Whole Mounts

1. The principles for immunostaining tracheal whole mounts are similar to those for 

staining lung sections, but since they are thicker, the incubation and washing 

steps need to be longer, 6 h minimum or overnight if possible.

2. Cut the trachea along the dorsal midline with fine scissors to make a flat whole-

mount. Pin tracheas to a Sylgard layer in a 6-well dish using insect pins.

3. Instructions for polymerizing Sygard184 silicone resin are included in the kit. 

Wear gloves. Add one part catalyst by weight to ten parts resin in a plastic beaker 

and mix gently, trying not to introduce air bubbles into mixture. Use a desiccator 

bell jar connected to a vacuum source to remove remaining air bubbles. Pour the 

resin into shallow plastic 6-well dishes or similar containers to a depth of 5–10 

mm. Allow to polymerize overnight on a flat surface.

4. Mouse tracheas can be processed in a small volume (1–2 mL) of incubation 

medium. Stretch the tracheas and pin them by the corners in the Sylgard dish, 

with up to eight tracheas per well. Incubate with gentle rotation or agitation at 

room temperature. Mount the tracheas with a gap between them and the silicone 

layer so that incubation solutions can circulate and reach both sides of whole 

mounts and be readily exchanged when washing.

3.10 Microscopy, Photography, and Tiling in Photoshop

1. Prior to observation with a fluorescence or confocal microscope, take the slides 

out of the refrigerator and let them come to room temperature for a few minutes 

so any condensation can evaporate (see Note 14).

12.VECTASHIELD with DAPI mounting medium (Vector Labs product #H-1200) is too weak to properly stain nuclei in thick tissue 
sections or tracheal whole mounts. However, it does contain a useful proprietary antifade agent than prolongs fluorescence and 
minimizes bleaching.
13.Use of 20× objectives and above will help prevent objective lenses with short working distances coming into contact with Cytoseal 
or other mounting medium that has not dried.
14.Keep the microscope stage clean and dry; wipe up any spilled liquid with tissue paper.
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2. Photograph the sections in appropriate color channels with camera exposure 

adjusted for brightness, contrast, and resolution. For conventional fluorescence 

microscopy, it is better to photograph red and green channels separately, rather 

than using dual band red/green fluorescence filters. Some bright fluorescence 

from one channel can bleed into the other channel. If this occurs, the bleed 

through image needs to be blackened in Photoshop (Window menu > Channels > 

select channel with bleed-through image > Edit > Fill > Black 100% > File > 

Save). Red and green channels can be pasted into R and G channels and 

separately adjusted and viewed in the Channels window (see Note 15).

3. Low magnification montages or panoramas of entire lung sections can be made 

by stitching together multiple photographs taken at a higher magnification and 

resolution. This “photo tiling” can be done with Photoshop or other applications. 

For example, 10–20 images at 5× are usually sufficient to make a panorama of an 

entire section of mouse lung (Fig. 2). Images at 5× have a great depth of field, so 

almost all lymphatics are in focus (Fig. 3). Photograph individual images so that 

they have about 30% horizontal and vertical overlap with adjacent images.

4. In Photoshop, open all of the individual images > File > Auto mate > 

Photomerge > select ‘Auto Layout’ (if not already clicked) and ‘Blend Images 

Together’ and click ‘Add Open Files’. Click OK. After processing, Photoshop 

will assemble the images into a seamless whole. If there are gaps in the image, 

the original photos have not had enough overlap with their neighbors and need to 

be rephotographed. Sometimes individual stray images can be dragged manually 

into the correct position in the panorama. The panorama will be in multiple 

Photoshop layers and will have a large file size. When you are sure the panorama 

is correct, flatten the multiple merged images (Layers > Flatten Image > Save as 

JPG). It is useful to take a photo of a calibrated micrometer scale slide (Ted Pella 

#2280–13) to calculate the final magnification of the panorama.

3.11 Pixel Intensity Analysis or Stereological Point Counting with ImageJ

1. The area density of immunostained lymphatics in images of lung sections can be 

measured with ImageJ (https://imagej.nih.gov/ij/ImageJ) after optimization in 

Photoshop.

2. Camera settings and Photoshop adjustments must be the same for all images in 

the batch being analyzed, because the measurement of area density is based on 

the percentage of pixels above a certain brightness threshold.

3. In Photoshop adjust the contrast and brightness of the color channel containing 

lymphatics, such that the background where lymphatics are absent is almost 

black and the lymphatics are bright.

4. Launch ImageJ and open the image (File > Open > select the image of interest).

15.When mistakes are made in Photoshop, they can be reversed by using the History window or the Edit > Step Backwards command.
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5. In the “Image” menu of ImageJ scroll down to “Color” then across to “Split 

Channels.” Keep the color channel containing lymphatics, and discard the others.

6. Select the region of interest using the “Freehand selection” lasso tool (fourth 

from the left in the ImageJ menu). Outline the whole lung with the yellow line 

(see Note 16).

7. In the “Analyze” menu of ImageJ scroll down to “Histogram” describing the 

number of pixels in the image with a brightness of 0–225. Click “Copy.”

8. Paste the data into an Excel spreadsheet, and calculate the total number of pixels 

with intensity 0–225 in the region of interest bounded by the yellow line.

9. Also in Excel, calculate the total number of pixels above the chosen brightness 

threshold, and calculate the percentage they represent of the total number of 

pixels. The absolute value of the brightness threshold is arbitrary but must be less 

than the brightness of the structures identified as lymphatics, and must be the 

same for all images being analyzed.

10. A plugin called Image-based tool for Counting Nuclei (ICTN) for ImageJ, which 

can be downloaded from https://imagej.nih.gov/ij/plugins/itcn.html, can be used 

for counting nuclei of Prox1-stained lymphatic endothelial cells.

11. Stereological point counting can be used as an alternative to ImageJ for 

measuring area densities. For this approach, a rectangular test grid is overlaid on 

the image, and points of intersection are counted manually. A plugin to create 

such a grid in ImageJ can be accessed by clicking Analyze > scroll down to 

“Tools” > “Grid.”
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Fig. 1. 
Schematic diagram of mouse heart and lungs showing incision sites 1: in right ventricle at 

origin of pulmonary artery for pulmonary perfusion; 2: in left ventricle for systemic 

perfusion; 3: across trachea for lung inflation. An 18-G plastic catheter is inserted at these 

sites. A thick slice of the middle portion of the left lung is prepared by cutting across sites 4 

and 5 with a scalpel when frozen in OCT and is further cut into 200-μm thick cryostat 

sections. Near the lung hilum the main bronchus and vessels can be readily identified; PA 
pulmonary artery, Br bronchus, PV pulmonary vein. The lung slice can be analyzed whole or 
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regionally using grids positioned at anatomical regions of interest. Modified from Fig. 1 in 

[7]
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Fig. 2. 
Low magnification panorama of 200-μm thick section of the entire width of the middle 

portion of left lung of a normal adult C57BL/6 Prox1-EGFP mouse prepared for 

immunohistochemistry according to the methods described. The section was stained for 

alpha-smooth muscle actin (red; Cy3- conjugated mouse anti-SMA, Sigma C6198) and 

Prox1-EGFP (green; Aves #1020 chicken anti-GFP). PV pulmonary vein, Br bronchus, PA 
pulmonary artery. (Asterisk) Cardiac muscle cells of the pulmonary vein express Prox1-

EGFP, but are more weakly stained than the overlying lymphatics. Scale bar: 1 mm
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Fig. 3. 
Enlargements of a region near the center of Fig. 2. Left lung of a normal adult C57BL/6 

Prox1-EGFP mouse stained for (a) Prox1-EGFP (green) and (b) alpha-smooth muscle actin 

(red). (c) merged image. Lymphatics (arrows) generally follow the scaffold of smooth 

muscle cells of airways and blood vessels, especially pulmonary veins (PV): Peripheral 

branches of the bronchus (Br) and pulmonary artery (PA) are closely associated in pairs, and 

separate from branches of the pulmonary vein. Each type of vessel has a characteristic coat 

of smooth muscle cells. The proximal portion of the pulmonary vein has a coat of cardiac 

muscle cells (asterisk), which express Prox1-EGFP, but are more weakly stained than 

lymphatics, and also has a thin coat of smooth muscle cells. Scale bar: 500 μm
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Table 1

Immunohistochemical markers of lymphatics and other cells in mouse lungs

Cell type Marker Host Vendor Catalog # Comments

Lymphatic endothelial Cells EGFP in Prox1-EGFP mice Chicken Aves GFP 1020 Overall best 
marker Strong 
signal. Marks 
cytoplasm and 
nucleus

Prox1 Rabbit Goat AngioBio R&D Systems 11–002P AF2727 Nuclei of 
lymphatic 
endothelial cells, 
neuroendocrine 
cells, and 
cardiac muscle 
cells

VEGFR-3 Goat R&D Systems AF743 Good, but 
weaker signal 
and higher 
background than 
Prox1

CCL21 Goat R&D Systems AF469 In Golgi 
apparatus of 
lymphatic 
endothelial cells

Neuropilin-2 Goat R&D Systems AF564 Endothelial cells 
of lymphatics 
and venules

Podoplanin Syrian hamster AngioBio 11–033 Clone 8.1.1 Not 
recommended 
for the lungs. 
Expressed by 
lung and 
tracheal 
epithelial cells.

LYVE-1 Rabbit Rat Goat AngioBio R&D Systems 
R&D Systems

11–034 MAB2125 AF2125 Not 
recommended 
for the lungs. 
Strongly 
expressed by 
blood vessels in 
lung [18], but 
not in trachea.

Blood vessel endothelial 
cells

Pecam1 (CD31) Armenian hamster Rat Thermo BioLegend MA3105 102502 Clone 2H8 
Clone MEC13.3 
Weaker 
expression also 
on lymphatic EC

Endothelial cells VEGFR-2 Goat R&D Systems AF644 Weaker 
expression also 
on lymphatic EC

High endothelial venules 
(HEV)

Rat (IgM) BD Bioscience 553863 Found in 
bronchoalveolar 
lymphoid tissue 
(BALT)

Smooth muscle cells α-smooth muscle actin Mouse Sigma Sigma F3777 (FITC) C6198 
(Cy3)

Marks large 
airways and 
blood vessels

Pericytes NG2 Rabbit Millipore Ab5320

Epithelial cells (pan) E-cadherin Pan- Cytokeratin Rat Rabbit Thermo Dako 13–1900 Z0622 Clone ECCD-2

Clara/Club cells CCSP Rabbit Millipore 07–623

Ciliated cells Acetylated tubulin Mouse Sigma T7451 Clone 6–11B-1
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Cell type Marker Host Vendor Catalog # Comments

Alveolar Type 1 cells Aquaporin-5 Rabbit Abcam Ab78486

Alveolar Type 2 cells SPC Rabbit Seven Hills WRAB-09337

Leukocytes (pan) CD45 Rat BioLegend 103102 Clone 30-F11

T-lymphocytes CD3e Armenian hamster BioLegend 100302 Clone 145–2C11

B-lymphocytes B220 Rat BioLegend 103202 Clone RA3–6B2

Neutrophils S100A8 A100A9 Goat Rabbit R&D Systems Abcam AF3059 Ab105472

Macrophages Iba1 F4/80 Rabbit Rat WAKO BioLegend 019–19741 123102 Also known as 
Aif1 Clone BM8 
Better in wax 
sections

Dendritic cells CD11c Rat eBioscience 14–0114-81 Clone N418 
Better in wax 
sections

Fibroblasts S100A4 Rabbit Abcam Ab27957

Mesothelial cells Mesothelin Goat Santa Cruz Sc-27702
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